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Purpose: 
This software was created in order to allow production and post-production sound 
professionals a means of examining audio Broadcast Wave Files and gathering pertinent meta-
data contained in each file and organizing that into a data format that can be easily read and 
shared by means of standard database exchange files. BWF -Widget Pro also allows you to edit 
this gathered database or even edit the Metadata contained in the broadcast wave files. 
 
Installation: 
Extract the zipped file to a folder on your computer's hard drive and run the Setup.exe file.  
The program should install in your program files folder and be available as a shortcut under 
program files titled: BWF Widget Pro 
 
System Requirements:  
Windows 9x, 2000 or XP. Or VISTA   
Windows Media Player 9 or later. 
Appropriate sound-card and sound output hardware for playback. 
 
If Installing on Microsoft VISA operating system you must have Administrator privileges to 
install and run the program. (Right Click on the EXE file or the Start Menu Icon for BWF-
Widget Pro and choose "Run as Administrator" from the drop down menu) 
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This software will not run natively on a MAC, but may have limited functionality on Windows 
running on Virtual-PC on a Macintosh. I haven't confirmed audio playback is supported on 
such a system. It does run well on Intel Based Macintosh computers which can run Windows 
OS under Boot Camp or Parallels. 
 
Operation: 
When you first launch BWF Widget you will be presented with a small window that shows 
some file-navigation list boxes and some fields where the resulting metadata is shown 
 
. 

Find your Wave Files: 
First select the drive from the 
drop down box that contains 
the broadcast wave files that 
you want to examine and 
catalogue. Then, using the 
folders window, double-click 
on the folder that contains the 
files of your project.  You 
should see all BWF or WAV 
files in that folder listed in the 
file list box on the right.  If 
you click on any file or use the 
arrow keys to navigate up and 
down the list you will be 
presented with the metadata 
for each file in the area below. 
Click the Radio Buttons to 
select what type of files to list. 
BWF, WAV, MP3 or ALL 
The ALL selection will show 
all media files including 
WAV, BWF, AVI, WMA, 
WMV, FLAC and MP3 
(BWF-Widget Pro 1.170 and 
later supports reading and 
editing metadata in FLAC 
compressed sound files created 
by the Sound Devices 744t and 
722t series Recorders.) 

 
 
 

NOTE:  Recent changes in the 
Windows Media player cause it to not play files that contain an iXML chunk and have the 
".BWF" filename extension.  If recording in a machine that uses iXML be sure to have it use 
the proper ".WAV" file extension for broadcast wav files. You should never use the" .BWF" 
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filename extension since it will limit the software that can play the files, and is not the proper 
filename extension for the broadcast wave file standard.  

 
Gather the Metadata for all files in the Folder: 
If you click on the "Fill Data Grid" button in the metadata display area the window will expand 
some and gather the metadata from every BWF or WAV file in the selected folder. If the 
selected folder contains Sub-folders a popup message box will ask if you want to include the 
files in the Sub-Folders. If you answer Yes, BWF-Widget Pro will gather metadata from every 
Broadcast wave file from every folder contained within the selected folder. Once filled, the 
data in the grid can be sorted by any of the listed meta-data elements.  The default sort is by 
Time Code in Ascending order if a single folder is selected, or by Path (folder name) if you 
choose to add files from multiple sub-folders. 
 
To re-sort the data in the grid on any other key just use the mouse to double-click on any 
header name at the top of the grid. The list will then be sorted in the order of that item.  If you 
Double-Click on "Scene #" label at the top of the grid the files will all be sorted according to 
Scene number then Take number respectively.  The grid coloring is designed to help you 
quickly determine where the sorted items change.  In other words, if you sort by Scene #, the 
row colors will change every time the Scene # changes.  Column widths are adjustable to allow 
for different width data. Just click and drag the dividers in the top label bar to adjust the 
column widths.  You can maximize the window to fill the display in order to see more columns 
in the Data Grid without having to scroll horizontally. You can also move or re-arrange the 
positions of the columns themselves. Just Right-Click on a column head and drag it left or right 
and drop it in the new position. In the View/Options Menu you can choose what Fields are 
included when filling the Data Grid. Just un-check any Metadata field in the list box that you 
don't want to include in the grid.  You must re-load the grid for your new choice to take effect. 
You can adjust the width of the columns in the grid manually by clicking and dragging the 
dividers in the header row.  Or if you double click on the Blue Title bar above the grid it will 
automatically set the column widths to accommodate the widest item in each column.  When 
you exit the program your custom column widths will be saved and loaded next time you start 
the program. 
 
Edit Metadata in the Grid-- 
 There are two places to edit the metadata. You can edit any field in the Data Grid.  This will 
only change the text that is saved as a Data File when you save the Grid Data.  The 
changes made in the Data Grid are not saved in the actual Metadata of the Sound File. Just 
select any field in the grid then press F3 to edit that field. Press "Enter" to save your changes 
to the grid or "Escape" to cancel the changes and return to the original data. This is useful for 
adding notes or marking preferred takes with an asterisk or other marker.  
 
To Edit the actual metadata in each file, see the section titled "Editing the Actual Metadata in 
the  BWF File" on page 10 of this manual. 
 



 
EDITING METADATA IN THE GRID 

 
Marking Printed Takes in Data Grid 
You can quickly mark printed takes in the Data Grid by clicking on a Take Number in the take 
column and pressing the “F4” Key.  An @ sign will be added to the end of any entry in the 
field. This will still allow the column to be sorted numerically but can be used to indicate 
which takes are printed when you save or print a report. If you make a mistake just press the 
“F4” key again to remove the @ symbol..  You can easily move down the data in the grid using 
the cursor keys marking printed takes with “F4” as you go. 
 
Save Collected Meta-Data to a file: 
If you click on the "File" Drop-down Menu bar, you can choose "Save Data File" from the 
menu or use the "Ctrl-S" keyboard shortcut, the program will immediately export the Data in 
the Data-Grid to a tab delimited text file and place it in the same directory as all the BWF files. 
If your files are residing on a Read only Media, like CD-Rom you will be presented with the  
"Save As " dialogue box when you click on the "Retry" button and allowed to choose another 
drive and folder for saving the file. The Filename automatically created by BWF-Widget 
reflects the name of the folder and sort order of the data saved in the text file.  This file can be 
loaded into Excel or any Database program that supports "Tab Delimited Text files"   
 
Save As ALE File for Metadata  and File Import to AVID. 
ALE is short for AVID Log Exchange format. It is a type of a ASCII Data file that is 
compatible with most AVID and some Pro-Tools Editing systems. Creating an ALE file will 
allow you to import the files and much of their metadata directly into an AVID editing project. 
To Save as an ALE file choose "Save Data File As" from the main File Menu. 
When the Save As dialogue box is displayed choose "AVID Log File (ALE)" in the dropdown 
selection box labeled "Save as type:"  Then when you click the "Save" button the ALE file will 
be created and saved to the folder you selected. 
 
NOTE:  ALE files must have certain metadata to be legal.  So make sure the following 
columns are in the Data Grid before you try to save an ALE file. 
The following 4 data columns are the minimum required for ALE file creation: 
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1 Filename: 2 Mode  3 Start TC 4 End TC 
The remaining metadata columns will be used as needed in the ALE file. The More metadata 
you include in the Grid the more complete the metadata in the AVID project will be. Especially 
useful are "Notes" and "Track IDs" 
 
Save a selection from the Data Grid to a file: 
You can use the mouse to select a subset of the entire data grid.  Click and drag across the 
column heads to highlight a series of columns within the grid or Drag down the Row Headers 
to highlight a series of row entries within the grid.  Then Right-Click on the selection and 
Choose "Save Selection" in the pop-up menu. You can also select a block of data within the 
grid by holding down the mouse button on the cell for the upper left corner of the block and 
dragging down to the lower right cell of the block you want to select. This subset, along with 
the column heads will be saved to a file with the prefix "SubSect" and the name of the folder 
and the type of sort.  Or you can use "Save Selection As" to rename the file and place it 
wherever you like.  You can also use "Save Selection As" to create an ALE file of just the 
selected takes. Simply choose "AVID ALE FILE" in the File Type Drop down in the Save As 
dialogue box before saving the selection.  
 
Copy a Selection from the Data Grid to the Clipboard 
A handy feature allows you to Select an area of data from the Data-Grid and Copy it to the 
Clipboard.  You can select a block of data or the whole grid then Right-Click inside your 
selection and choose "Copy Selection to Clipboard". You can then go to any application that 
supports Paste (Like Word or Excel) and paste the data directly into a spreadsheet or a word 
processing document.  The headings are automatically taken with the data so if you don't need 
them just delete that row of labels after you paste the data. 
To quickly Select the whole Grid just Click on the # sign in the upper left hand corner of the 
Data Grid. 
 
Printing a List of the collected data Grid: 
If you have a printer attached to your computer you can choose "Print Report" from the drop-
down File Menu. If your data won't fit on the page width you can either change the printer 
settings to Landscape Mode to print horizontally or you can change the size of the printout font 
in the View/Options menu to allow more data to be displayed on a row. The width of each 
column in the printout is set automatically to accommodate the widest data item in the column. 
The options Menu (under View) also contains some checkboxes that control whether a 
separator line is used to separate rows that have changed in the printout. This line is inserted 
wherever the background color changes in the data grid. This is useful if the Grid is sorted by 
Scene # as a line is drawn at the end of each scene. This makes the printout much easier to 
locate and read specific items. You can choose a column to base the change color on that is 
different from the sort order by placing the cursor in a column of the grid on which you want to 
base the color change, and pressing "F11". The grid will then be re-colored (and devider lines 
will be placed in the printout) based on when the data items in that column change.  
 
Sound Report Printing: 
You can select "Print Header" checkbox in the options menu to create a Sound Report Header 
to be added to the top of page one. To enter or edit the data for the header choose View Header 
Data from the View Menu or use the HotKey "CTRL + H". You will see something like the 
form below. 
 



  
Header Information Data for Sound Report 

 
Fill in your pertinent data in the Text boxes and then just close the window. The data will be 
saved and recalled each time you start BWF-Widget Pro. To change the Disk number you can 
simply click on the "Disk #" label to increment the disk number (right click to decrement) or 
just directly type a number in the box. This Roll/Tape/Disk number will be used as the default 
Tape name if your files do not contain a Tape or Roll Number in their metadata.  If the Tape 
Field in the Metadata panel is Red in color it means that it was taken from your sound report 
header and not from the file itself. So you might want to make sure you set the Roll/Tape/Disk 
number to the correct value before reading the metadata into the grid. (this is only required if 
you are including a column for the tape field in your data grid) 
 

You can customize the report header by replacing the BWF-
Widget Logo in the upper left hand corner with your own 
logo.  Simply create a BMP file that is approx 400 pixels by 
200 pixels and name it "HeadLogo.bmp" and place it in the 
same folder as the BWF-Widget Pro Program file.  Your 
custom logo should then appear in the printouts and in the 

preview and data entry screens for the Header. You can use picture files of higher and lower 
pixel counts but the aspect ratio of 2 to 1 (width to height) should be maintained or your logo 
will be distorted. You can also customize your Sound report fields or use a different language 
for the different field labels. Hold down the “SHIFT” key while clicking with the mouse on 
any of the field labels to edit them. Press “Enter” to update the label to your new text or press 
“Esc” to abandon editing and return the field to its previous label. When you close the window 
all the fields and their respective labels will be saved to disk and load automatically each time 
you display the header. You can use this feature to change the Header text to a different 
language for report printing in the language of your choice, or for custom information needed 
for your project.  If the top of your printout is being cut off by your printer you can add up to .5 
Inch Top Margin to the Header using the slider control. 
 
NOTE: The "DATE:" field automatically loads the current system date each time you open the 
Header Entry window.  To disable this Auto-Date function simply change the field label from 
"DATE:" to something else.  You can just add a space between the "E" in DATE and the ":" 
colon will change the field enough to disable the Auto-Date entry.  You may then manually 
enter the date or any other entry you may want in that field.  To re-enable the Auto-Date 
Function change the Field Label back to "DATE:". 
 
 
 

© Copyright 2006- 2008 - Courtney M. Goodin  all rights reserved 

6



You can click on "Print Preview" in the file menu to preview your sound report.  If you don't 
have a printer connected you can create a PDF file of the Sound Report  to be stored on the 
disk along with the sound files.  To do this you need a PDF generation program like CutePDF 
Writer (Free download from: " www.cutepdf.com. ") or Adobe Acrobat or other PDF printer 
Emulators.  Just select the PDF Printer as your Printer to use for Reports from the Options 
Menu.  Note: from the View menu select Options to display the Printer Settings. You can 
select the printer to use for your Sound Reports as well as the font size and whether to print in 
Portrait or Landscape. You can Preview the Report by pressing the "Preview" button in the 
Printer settings of the Options Menu to observe how the settings will affect your printout. More 
Comprehensive Printer settings are available from the Printer Setup which can be selected from 
the File Menu. To Quickly change the number of copies Left Click on the label "Copies = 1" to 
increment the number of copies or Right-Click to decrease the number. 
Remember if you are printing to a PDF file only a single copy is allowed. 
 

 
Printer Settings in Options Menu 

 
You can also select a portion of the Data Grid for printing. Use the mouse to select a block of 
data in the grid then Right Click on the block and choose "Print Selection" from the pop-up 
menu.  When printing a selection, the Sound Report header is not part of the printout although 
the column labels will be printed..  
 
Find Files: 
From the "File" dropdown menu choose Find Files or press "Ctrl - F" hotkey to bring up the 
Metadata Based File Search window. This window allows you to type in a Time Code 
(formatted as HH:MM:SS:FF) or User bits or just Text contained in the metadata to assemble a 
list in the Data Grid of all files that contain the search criteria. If your files contain meaningful 
Track Names  such as "TRK1=Tom's Lav" or TRK2=Boom. You can enter any text in the text 
search field and if that text exists in the metadata of the file that file will be added to the grid 
when you click the "Find Files" button.  
 

 
 

 
 

© Copyright 2006- 2008 - Courtney M. Goodin  all rights reserved 

7



If the search Subfolders checkbox is checked, all folders contained at the current level of the 
current folder will be searched for the Text  User Bits or Time code. You can enter a Scene 
number in the Text field to search for all files that contain that Scene number. If you search for 
a Time Code the program will return all files that contain that TC within the duration of that 
file. 

 
Copy Files: 
You can now use BWF-Widget Pro to copy selected files to new locations.  Just use the mouse 
to select 1 or more rows in the Data Grid. Then Right Click on the Selection and choose "Copy 
Selected Files"   
 

 
 
Besides using the mouse to select a range of files or clicking on the # sign in the upper left 
corner to select the whole grid, you can use the “Red-Tag” method to select any number of 
files anywhere in the data grid. Use the “T” key to toggle the Red Tag on and off for any 
selected file or selected group of files..  The Number in the first column will change to Red to 
indicate it has been “Red-Tagged”.  To Un-tag all files press the “U” key.  All Red-Tagged 
files will be reset to Untagged.  After you Red-tag any number of files you can then right click 
on the grid and choose “Copy Red-Tagged Files” 
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Red Tagged Files ready to copy 

 
This will bring up the copy files Window with the files you selected in the pane on the right. 
Navigate to path where you want to copy the files in the file boxes on the left. Use the New 
folder button if you need to create a new folder in the current path. Then click the copy files 
button to start the copy process.  
 

 
 
 The status Line shows the progress of the operation. You can press the cancel button while the 
copy is in progress the program will complete the current file being copied and then abort.  
When Done click the "Done" Button to close the File Management Window. 
 
You can also choose “Remove Red-Tagged files from Grid” to remove files from the grid 
before saving a data file or printing a log.  To invert the selection of Red-Tagged files, click on 
the “#” sign in the upper left corner of the grid to select all the items in the grid. Then press 
“T” to toggle the selection.  All Red-Tagged files will be revert to Untagged and all Untagged 
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files will change to Red Tagged. Removing items from the Grid does not remove them from 
the disk, it only removes them from the current collection in the Grid. 
 
File Playback: 
Currently BWF Widget Pro allows you to play any file as long as your computer's audio 
hardware supports the bit-rate, word length and track count of the audio file.  Most Stock 
Windows PC's currently only support up to 16 bit PCM sound files at up to 48048 Khz sample 
rate*. If your files are mono or 2 track16 bit 48k they should play by either double-clicking on 
the filename in the file list box or double-clicking on any Item in the Data Grid.  BWF-Widget 
Pro Version 1.142 and later incorporates a patch to the Windows Media Player that allows you 
to play 24 bit and multi-track files on a laptop or PC that only has 16 bit hardware. However, 
for discrete multi-track playback of full dynamic range files you may want to upgrade to a 24 
bit / 5.1 or 7.1channel sound card. While BWF-Widget Pro can playback up to 8 tracks on a 2 
track system you will have no individual control over level on tracks numbered higher than 2 .   
 
WARNING: Attempts to play more than 8 tracks without proper multi-channel audio 
hardware installed may cause Windows to Crash or Re-Boot. (known bug in Windows Media 
player) So unless you have an Audio Interface that supports it and the proper drivers do not 
attempt to play more than an 8 track poly file in BWF-Widget Pro., BWF-O-Matic or Windows 
Media player. 
 
Click on the Button labeled “TC Window” to display the real-time TC display that shows you a 
large sizable floating Time code window that will track your file as you play it. 
 

 
 
This window displays the Scene and take number for the playing file if that data is contained in 
the Meta-Data.  The Tracker is the small vertical  rectangle that tracks across the Time code 
display as the file plays.  You can click and drag this tracker when paused (it turns yellow 
when paused and red when stopped) to move to any position within the current file. Or you can 
simply click the mouse pointer anywhere on the Purple Tracker Bar to instantly move to that 
relative position in the file. There are also Hot-Keys that control playback.  Pressing "Enter" or 
"P" from the Data Grid or File List box will play the file at the current cursor position.  Once 
playing the "Space Bar" allows you to Pause and Resume playing the current file.  Pressing 
“Esc” key will stop playback and pressing "P" Key will re-start playback from the beginning. 
When paused, you can use the Left and Right Cursor Keys to move 1 frame Back or Forward.  
Hold down the Shift Key with the Cursor keys to move 1 Second at a time forward or 
backward.  You can adjust the Left-Right balance of a 2 track playback by using the mouse to 
Right-Click in the Tracker Bar to set the balance from Left to Right Channel.  The small purple 
line indicates the Balance Position in the tracker bar. If you find the Hot-Keys are not 
controlling the playback it is probably because you have clicked on some object that has stolen 
the focus. If you find this to be the case just Click on the BWF-Widget Logo in the upper left 
of the Window. This should restore the Playback to Hot-key control. 
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Cue Marks 
Any cue marks set in the file when it was recorded will show up in the Metadata area in the 
Cues drop down box.  Choose a cue from the dropdown to move to that location in the file. 
Once you choose a cue mark you can instantly jump back to that cue by pressing the “C” key 
when the file is playing or paused. You can add new cue marks at any time by pressing the 
“M” key when the file is playing or paused.  This will drop a new cue and set it as the current 
cue point that you will return to when you press “C”.  A small number appears along the top of 
the center tracker bar in the TC window indicating which cue number is active and where you 
will return to when you press the “C” or Cue key.  
 

 
 
 You can add as many cues to the file as you like. These are temporary unless you decide to 
save them to the file by pressing the “Save” Button next to the cues Drop-Down box. (See 
figure below)  to move between cues you can either choose a new cue from the Drop Down 
Cues box or use the Keyboard shortcuts of “N” for Next cue , or “B” for Back one cue. 
Those keys will move you through the cues that have been set in the file. 
If  you turn on Reaction Compensation by checking the box in the Beeps & Pre-Roll Control 
menu. (see next section) Cue-marks can be more accurately dropped while playing the file 
(using the "M" Key). When Reaction compensation is turned on,  the playing file will backup 
1/4 of a second (normal reaction time) and set the Cue mark there and then continue playing. 
Don't worry if you miss slightly because you can adjust the cue marks in 1 frame increments at 
any time. To adjust the position of a cue, first select the cue then position the tracker in the file 
to the position where you want the cue to start. (use the left and right arrow keys to move 1 
frame or Shift Arrow keys to move 1 second in each direction)  When you have the new 
position selected press “Shift M” to move the currently selected Cue Mark to your current 
position in the file.  
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Out Cue: Whenever you set or locate to a Cue Mark the "Out Cue" marker becomes visible. It 
is represented by a vertical red line and initially is set at the end of the file. When playing a file 
and the tracker reaches the "Out Cue" point, the playback will pause and instantly Re-Cue to 
your currently selected cue point (or to the pre-roll point before the cue). You can set the Out 
Cue to any position in the file by simply pressing the "O" key for "Out Cue" while the file is 
playing or paused. Holding down the "Shift" key when pressing "O" will cause the Out Cue to 
be placed 1/10th of a second before the end of the file.  That way you can have the player 
automatically re-cue to your cue point and be ready to play again if the playback reaches the 
end of the file. There is only one Out Cue marker and it is only temporary. It is not saved and is 
re-set to the end whenever a new file is selected.   The Out Cue is also disabled if the "Auto 
Play Next" feature is turned on. (See section at end of manual) 



 
If you choose to Save cue points in the file press the “Save” Button that appears to the left of 
the Cues Drop Down box, a new Cue chunk will be added to the file or if one existed already, 
it will be updated with any new cues you added.  This  “Save” button  will only appear if you 
have added cue Marks in the file and if the file is an uncompressed WAV or BWF file. You 
will be asked if you want to save your new Cues whenever you try to move to another file and 
haven’t already saved any cues you may have created. 
 

 
 
 
Advanced Playback features can be accessed from the Debug & Tweak Window. See that 
section for information about .1% Pull-Up and Pull Down or Off Speed Playback. 
 
*Note: SoundBlaster Audigy2 soundboards and USB Audio devices support 24 bit and 96khz 
playback as well as multi-track (up to 8) tracks of sound playback.  You must have sound 
hardware installed in your computer that can handle the bit-depth and discrete tracks of your 
playback. If you only have 2 channels of audio on your machine additional tracks (3 through 8) 
may be heard, but you may have no control over their level and they appear at both Left and 
Right outputs. 
 
Countdown Beeps 
This powerful feature lets you instantly add count-off beeps leading in to any cue point in a 
playback track without having to edit the original audio file. This is useful when using BWF-
Widget Pro to playback tracks for on-set  "poor man's ADR" or when using it for Music or pre-
recorded dialogue playback. 
 
Preparation--: Prior to using the Countdown Beeps feature you may want to set the default 
beep sound in Windows (which this feature uses) to the short 1kBeep.wav or Blip.wav file 
provided with Bwf-Widget Pro in the BWF Widget Pro folder under Program files. To do this 
make sure you copy the files: "1kBeep.wav" and "Blip.wav" to the \Windows\Media folder on 
you computer.  Then go to the Windows Control Panel and choose Sounds and Audio Devices 
setting. Click on the "Sounds" tab and scroll down and select "Default Beep" in the Program 
Events window. Click the Browse button and choose either the blip.wav or 1Kbeep.wav file as 
the default Beep. Then click Apply to save your new choice. 
 
To Use the Beeps--:After you have set one or more Cue Marks (see above) bring up the beep 
control panel by simply clicking in the upper left hand corner of the Time Code Window. Or 
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choose "Beep & Pre-Roll" from the View Menu. (or use the "Ctrl-E" keyboard shortcut) This 
will pop up the Beeps and Pre-Roll control menu. Click on the drop-down box to choose the 
number of beeps you want to hear before the Cue. (From No Beeps to 4 Beeps) 
See figure below: 
 

 
Beep and Pre-Roll Control Menu 

 
Countdown beeps can be used in 2 different ways.  
 
1. If Pre-Roll is set to 0, the Beeps count down and then file starts playing instantly from the 

currently selected Cue point. 
 
2. If there is enough sound in the file prior to the Cue point, you can set the Pre-Roll to roll the 

track and trigger the beeps as the track approaches the Cue point, ending precisely at the 
chosen Cue. This method is used if you need to have the camera shoot the TC slate or BWF-
Widget TC display with the playback file running its lead-in Time code for a head-slate 
prior to the cue point. 

 
You can adjust the Beep Interval using the slider control so the beeps can closely match the 
tempo of a music track. A new feature allows you to set the Beep Interval by just tapping the 
"F12" Key in time with the playback.  You will hear beeps as you tap and you just need to tap 
it 3 or 4 times to establish the interval. (it averages the interval of all the taps) 
 
After setting the Beep Interval you click on the < symbol to increase the pre-roll time. The 
minimum pre-roll allowed is equal to the number of beeps +1 times the Beep Interval, so 
choose your beep interval first, then increase your Pre-Roll setting. You can add additional 
silent beep intervals to the Pre-Roll time by continuing to click on the < symbol in the Beep 
control menu as long as additional time is available in the file before the cue point. Now, 
whenever you re-cue the file (by pressing the "C" key) the file will cue up at the Pre-Roll point 
and be ready to play.   A small popup Countdown window will appear between the Scene and 
Take labels on the bottom of the Timecode Window. When you press the Spacebar to start 
playback, it will count down the Beep intervals until the cue is reached and then disappear after 
the last beep and exactly on the Cue. To have pre-Roll without audible beeps just set the Beeps 
Drop down to "No Beeps".  The countdown window will still countdown to the cue but no 
audible beeps will be generated. 
 
NEW: -- Shortcut  Hot-Keys to Set Beep Count and Pre-roll:  Press SHIFT + 1 to set to 1 beep 
or SHIFT+4 for 4 beeps etc. or SHIFT + 0 (Zero) for No Beeps.  And use SHIFT+"<" (less 
than) to add pre-roll time or SHIFT + ">" (greater than) to remove more pre-roll intervals. 
 
Note: The Countdown beeps are only generated on playback in BWF-Widget. They are not 
added to the actual sound file.  The original sound file is un-changed and can be sent off to 
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post-production for transfer or sync-up without concern about the beeps used to cue talent 
when on the set. 
 
Q 2 Q Playback 
Also available on the Beep Control panel, is the check box marked "Q-2-Q". This places you in 
Q-2-Q mode which will playback from one Cue mark to the next.  When you press the "C" key 
to cue up to your currently selected marker, yellow tic-marks will appear at each subsequent 
cue mark in the file. When you press the Space Bar to play from the Cue,  the file will play 
right up to 1 frame before the next cue mark and then pause. You can then tap the space bar to 
play the next cue and so on.  This is useful for playing back off stage lines or a series of music 
cues. Just put all the lines or music cues in a single file and place markers at the beginning of 
each cue. You can easily Cue each response line in time to some live action in the scene. (like 
one side of a phone conversation where the actors pacing is not known)  This mode also works 
well with puppets or animated characters lines in a live action scene. 
Pressing the "C" key will re-set you to the first selected cue marker in the file and make you 
ready for the next take. 
 
Wireless Remote Control: 
In the Options menu under Foot Pedal Control there is a check box for " 
Presentation Remote Control" . (See Below).  This allows you to use a 
wireless remote control like those used for PowerPoint presentations to 
control playback and re-cuing of the audio. These controllers usually have 
4 buttons for Next Slide, Previous Slide, Start Show and Blank screen.  
When the checkbox for Presentation Remote Control is checked the 
remote control keys function as follows:  
 
Next Slide=Play / Pause (same as space bar) 
Previous Slide= Cue up (same as C key) 
Start Presentation= Toggles between Play (P key) and Stop (S Key) 
Blank Screen= Jump to Next Cue in Cue list  (N-Key) 
 
This feature can come in handy if you need to give someone else control 
over starting playback. (like the director or lead musician or a Puppeteer 
firing off pre-recorded lines)   
Quite useful using the Q-2-Q mode mentioned above. 

 
 

View Raw Data: 
Clicking on the "View Raw Data" Button will display the "Chunk Viewer" text window at the 
bottom of the Data-Grid that displays the raw data in a textual format. A Wave file is made up 
of several chunks of data. This viewer allows you to view all the chunks contained in the 
selected file. You can view all the contents of the BEXT (Broadcast Wave Extension) Chunk 
or other data chunks of the currently selected file.  This is useful for trouble-shooting Metadata 
layout and contents of any particular Broadcast Wave File. To view the contents of each chunk 
simply click on the small 3 or 4 character label at the top edge of the Chunk Viewer. The 
"data" chunk will only display the first 6000 bytes of the chunk since this chunk can be very 
long and viewing it in a Text window is of limited use. If your file contains iXML data you can 
view it and edit it in the Chunk Viewer. To close this windows just click on the button which 
now says "Hide Raw Data". 
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Edit actual Metadata in the BWF file 
Bwf-Widget Pro allows you limited ability to edit and add tags to the metadata contained in the 
bext chunk of BWF files. Select the file you want to Edit in the File List Box and then click the 
Edit Metadata Button at the right of the Metadata view pane.  This pops up a text editing box 
which allows you to edit the 256 byte user Metadata from the Bext Chunk. 
 

 
 
In the lower right corner is a counter that shows you how much free space you have to work 
with in this chunk. As you add text or delete text this number changes to let you know if you 
are running out of room. The star-like symbols are fillers that indicate visually how much 
space you have remaining in the chunk. These should be kept at the end of the text, after any 
entries you may add.  When you are done making changes or adding meta-tags click on the 
"Save Changes & Exit" button to update the BWF file with your changes. If you press 
"Cancel" no changes will be made to the file and the edit window will close.  You are not 
allowed to change fields in the metadata like Recorder Name, Date, Time Created Sample 
Rate, number of channels, etc. or  The Coding History data at the end of the Bext Chunk.. 
Changing that data is not allowed because they all are related to the actual structure of the 
audio data in the file and that structure cannot be changed by this program. 
 
At the right side of the Edit Window is a scrolling list of common BWF Tags that can be 
inserted in the Metadata window by simply double-clicking on a tag. If the tag already exists in 
the window, the cursor will be placed at the right of the Tag (right after the Equal Sign)  and 
you can then edit the existing data or add new tags (up to the limit of free bytes). If the new tag 
is not already in the metadata it will be added at the bottom of the list and the cursor is placed 
at the end ready for you to enter the user originated information.. End each line with a carriage 
return. 
 
Altering the Start TC 
Although it is not advised since it will change the actual Time Code in the broadcast wave file, 
you can edit the Start Time Code to be whatever you want.   You can do this in two different 
ways. One way is to double-click on the Start Time Code displayed in the Metadata Window 
for a file. This brings up a white Edit box with the current Time Code in it. 
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Edit the Hours Minuets Seconds and Frames to whatever value you want. Then press "Enter" 
to apply your new start time. Press Esc to cancel any changes.  
 
The second place to change the Start time is to playback the file and pause at any point within 
the file. Use the tracker in the TC window to position yourself at a known position in the file.  
Double click on the Tracker in the Time Code Window to bring up an edit box with the Time 
Code of the current position within the file. (See Below) 
 

 
 

Edit the numbers in the box t be whatever time you wish this point in the file to be. 
Then Press "Enter" to apply the new Time Code. BWF-Widget Pro will then calculate the new 
Start Time Code and set it for you. These Changes are temporary and will be applied only to 
the Time Code display while you are playing the current file.  You can however make your 
changes permanent if the file is a Broadcast Wave File and has a "bext" chunk. 
 

 You .save your changes to the bext chunk in the file by 
double-clicking on the "Start Time Code:" label in the 
Metadata Window.  If it is possible to save the Time Code 
in the current file, a button will appear that says: "Save 
TC". Click the button to update the time stamp for the file 
with the current values shown opposite the label. These 
changes will be permanent and the file will now have a 

new Start Time Code. There is no Undo function for this operation so be sure you want to 
permanently change the Time Code stamp in the file before you click the "Save TC" button. 
 
Using "Time of Day" for Time Code 
If the files were recorded on a recorder that was not a Broadcast Wav recorder and has no  
SMPTE Time Code, but does have a built-in Real time clock that puts the standard time/date 
stamp on the files, you can use this file date-modified time to set the TC clock when you are 
playing the file. This can therefore allow you to use the Real-Time Clock in the small mp3 
recorder as a "poor man's timecode". Just synchronize the RTC in your MP3 recorder to your 
camera's time code by manually setting it exactly at a minute transition.  This works great on 
MP3 files recorded on recorders like the Marantz PMD620 or other portable MP3 recorders 
that may be used for transcription. However your camera must be running with time code that 
stays in sync with real time. (30 Frame Non drop, 29.97 Drop Frame, or 25 or 24 frame TC). If 
your camera is using 29.97 Non Drop or 23.976 Frame Time Code the RTC in the recorder will 
drift out of sync after only a few minutes. 
 
 

© Copyright 2006- 2008 - Courtney M. Goodin  all rights reserved 

16



 
 To use the file's time/date stamp to set the time-code 
clock just do the following:  While the file is playing in 
BWF-Widget pro, just Double-Click on the legend 
label "Time of Day:" in the metadata window. 
 (see picture at right). 
 
Since this time and date reflects the time the file was last modified, it usually corresponds to 
the time of day when the file finished recording.  BWF-Widget Pro will then take the time and 
date from the file and calculate the start time (within one second) and set the Time Code clock 
to this number.  Since the file's time stamp is only stored to the nearest second, the accuracy 
can only be plus or minus 1 second. If the file contains no "User Bits" of Standard Time Code, 
the file's date will be entered into the User Bits field in the form  MM\DD\YYYY. 
 
 
 
NOTE: Although you can alter the Start Time Code of standard WAV or MP3 or WMA files 
while the file is loaded and being played back, you can not save the altered start times to those 
files because they have no Time Stamp in the file itself. You can only save the altered Time 
Code Start times to Broadcast Wave Files that already have an existing Time Stamp. 
 
If you try to save the time code to a standard PCM Wav file 
you will get an error message as shown at the right. 
 If you click the “Yes” button, a bext or Broadcast Wave chunk 
will be created and added to the PCM wav file thereby 
converting it to broadcast wave.  The Time Code shown in the 
Start Time Code: box will be used as the start time stamp for 
that file. The Date and other data will be taken from the original file. 
 
If you click “No” the file will not be changed and the Time Code will not be able to be saved.    
MP3 and WMA files can not be converted to Broadcast Wav files by this program.  If you 
want to convert a large group of standard PCM Wav files to Broadcast Wav, Gather their info 
into the Data Grid then use the Batch Converter to convert the whole batch.  (see the section on 
batch convert Red Tagged or Selected files). 
 
 
Editing iXML metadata  in the file. 
If your file contains iXML metadata you can use a process similar to the above BEXT editor to 
change and add to the iXML stack of information.  Open the Chunk Viewer by pressing the 
"View Raw Data" button. If your selected file contains an iXML chunk you will see it 
indicated in the title bar of the Chunk Viewer.  Click on "iXML" to display the current iXML 
data. At the right of the title bar of the Chunk Viewer is a button Labeled "Edit iXML" Click 
this button to put you in Edit mode.  
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Then you can make any changes to the iXML data in the window. As in the BEXT editor you 
are shown a number at the bottom of the window that indicates how much free space is 
available for editing. Spaces at the end of the data are converted to Star characters while 
editing to indicate visually the number of characters available for adding text. If no "Stars" are 
visible at the bottom of the iXML chunk or  if this "Free" number is 0 you can not add any 
iXML metadata.  You can remove or change data as long as there is space available.  For more 
information on the iXML format and allowed tag names and Syntax rules contact the 
manufacturer of the machine used to create the file.  Remember that iXML metadata is usually 
a duplicate of metadata found elsewhere in the file. If you make editing changes to the iXML 
data you should check the Bext Chunk to see if there are changes to be made there as well.   
BWF-Widget pro pulls its metadata from both the iXML chunk (when present) and the Bext 
Chunk. If the metadata for a particular field is found in both the iXML chunk and the Bext 
Chunk then the data from the Bext Chunk takes precedence and with be the data used in the 
display. Because the iXML chunk is more difficult to parse it can slow down the gathering of 
metadata considerably.  If you metadata you need is all contained in the Bext chunk there may 
be no need to parse the duplicate data in the iXML chunk. There is a checkbox in the Settings 
and Options Menu that allows you to ignore the iXML data when filling the grid.  This will 
speed up filling the grid if you have an unusually slow computer.  You can test to see if any 
changes happen if you have the box checked and then unchecked when you fill the grid.  If no 
data is missing when you fill the data grid you can safely ignore the iXML data.  The iXML 
data will still be in the file, but BWF-Widget pro will not use it to populate the grid. 
 
View  Settings & Options: 
You can go to the View Menu and select "Options" to change settings for playback and 
Printing of files.  You can also select new color schemes for the TC window and Grid. Use the 
mouse buttons to select a new foreground and background color for the sample text. Then 
double click on the labels below the sample text to apply those colors to the respective objects.   
The grid colors cycle through 1 to 4 in order so if you want only 2 colors (the default) then 
color Grid 1 and Grid 3 and Grid 2 and Grid 4 to be the same. Note: when you change the grid 
colors you must re-sort the grid to see the results. Click on the “Default Colors” button to reset 
all the items to their default colors. 
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OPTIONS MENU 

 
The Options menu is where you select which fields will be included each time you "Fill the 
Data Grid"  Check the boxes for the fields you want to include in your reports. If you check the 
box labeled "Unparsed Comment Field" Then BWF -Widget pro will not parse the comment 
field where certain sub fields data like Scene, Take and Roll number is stored  
When this box is checked, the Un-parsed info in the BWF comment field will be placed in the 
Notes Box in the metadata display and in the Notes Field in the grid.  
 
Also, the Options menu allows you to control options like the printer to use for Report printing 
and the Printout Font size. Or whether to add separator lines to the printout, and whether to 
print the "Sound Report Header" on page one of your printouts.  You can also choose to Flag 
overlapping or duplicate Time Code. (when you sort by Time Code, files that overlap or 
contain the same time code will be highlighted in Red.) Flagged files will also be "Red 
Tagged" so they can be easily copied to another folder to eliminate the same folder duplication. 
Also in the Options menu is the Default Time Code. Rate.  This is the rate that will be used if 
the original TC Rate is not listed in the Metadata of the file. (appears as "xSPEED=030.000-
ND"). If the Frame Rate shown in the metadata window is RED it indicates that the Default TC 
Rate is being used.  If it is Black then the Frame Rate is being pulled from the SPEED= xxx.xx 
Metadata in the file. 
 
You also can choose whether the current Time Code is automatically put on the Windows 
clipboard every time you pause or play a file.  This is useful when using BWF-Widget Pro for 
logging time-coded audio files. Playback the file and press the spacebar to pause.  Then go to 
your word process or logging software and paste in the Time Code  and proceed to type the 
description or transcribe the dialogue. To display the TC paste settings select "Foot Pedal 
Settings from the View Menu. 
 

 
 

© Copyright 2006- 2008 - Courtney M. Goodin  all rights reserved 

19



DeBug & Tweak Window 
From the View Menu click on "Debug & Tweak Window". (or Press the HotKey "Ctrl B")  
This window pops up underneath the TC default location.  Drag the Time Code window out of 
the way to view the Debug & Tweak Window.  This window contains tools for  Advanced 
users and allows tweaking of a file's Sample Rate and Time Code Values as well as the ability 
to Playback a file at Off speeds for sync playback with film cameras for certain visual effects. 
(Common in Music Video Production) 
 

 
 
WARNING: The tools in the Debug and Tweak Window make changes to the Format 
chunk and BWF chunk of the file. Since it is possible to permanently change your files to 
a point they may become un-playable, you should only use these functions on copies of 
files rather than the original file. Also these tools can only be used on files that are 
capable of being re-written (will not function on files residing on CD or DVD+-R disks) 
 
The Pull Down .1% and Pull-Up .1%. These buttons offer an easy way to pull-up the sample 
rate and therefore the Speed of playback of a file by .1% Necessary for Files that will be 
matched to film played back in NTSC Telecine. If the Re-Calc TC Stamp is checked, the Time 
Code stamp at the head of the file is automatically counter-adjusted to compensate for the .1% 
change in the Sample Rate.. The Time code Number for the start of the file should not change 
when the Re-Calc Box is checked. If  the Box is Un-Checked the timecode stamp in the file 
will be un-changed but because the sample rate changes, the resulting  calculated Time Code 
will shift every time you change the sample rate.  It can be shifted back by also editing the 
BWF Metadata xSPEED=xxx.xxx-ND Tag to reflect the .1% change.   
 
For example if you want to Pull Up a file Recorded at 29.97 FPS to 30.000 FPS Timecode,  
Either leave the Speed set to 29.97 in the Metadata and Check the Re-Calc Box and click the 
Pull Up .1% Button.   Or you could Un-Check the Re-Calc box, Click the Pull Up .1% button 
and then go Edit the Metadata to Reflect the .1% pull up in the TC Rate to "xSPEED=030.000-
ND". If this sounds confusing it is because it IS CONFUSING.  Time code in a BWF file is 
affected by the Sample Rate,  Time Code Rate, and TC Stamp in the file header.  Changing any 
one of these without compensating the others can result in the Time Code being shifted to an 
incorrect value. 
 
If you are using BWF-Widget Pro for Playback of music for a Film, you can use the Pull-Up 
.1% button to adjust the playback track used on the set so that when the film is slowed down 
.1% in Telecine it will match back to the original 29.97 FPS TC on the music master. (leave the 
Re-Calc Box Checked) 
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A word of caution:  Not all computers are created equal.  Some Sound Chipsets are Locked at 
44.1k and 48k and will not playback the 48048 hz  or 44144hz file at it's pulled up speed. You 
can check your playback machine by recording a 10,000 Hz tone on a file and testing the 
playback with an accurate frequency counter hooked up to the output. You should see the 
frequency shift by .1% when you speed up or slow down the file by the same amount. If it 
doesn't change then your machine and /or its drivers don't support subtle changes in sample 
rate. 
 
Off Speed Playback. 
This small sub window in the Debug & Tweak window contains a tool to let you change the 
playback speed to match a camera that is not rolling at normal 24 or 30 fps sync speed.  Many 
times for effect in Music Video production the DP may want to Over-crank or Under Crank the 
camera to achieve an unusual effect but want the singer to stay in sync with the track..  This 
utility should be used to change the speed of the playback the exact same ratio and will adjust 
the sample rate and Time Code Stamp as well as the TC display to compensate for the off-
speed playback. The time code will count at the Faster or Slower Rate and maintain sync with 
the original track when the film is played back at normal sync speeds in Telecine.   
 
For example:  Record your tracks as BWF files at 29.97 or 23.976 FPS Time Code. 
Then enter the New Camera Speed in the Text box and press the Set Speed button. If the Re-
Calc TC box is checked the sample rate will change to reflect the change in camera speed equal 
to the ratio of the Telecine Speed (29.97 or 23.976) to the current Camera Frame Rate. This 
ratio appears in Red to the right of the Set Speed Button. 
 
IMPORTANT NOTE: If your file is using a Timecode rate that is not equal to the actual 
frame rate of the camera. (i.e. 30 frame TC and the camera is a film Camera that is rolling at 
24fps). Double click on the Green Label that says  "No 3/2PD" until it reads "With 3/2 PD". 
That sets the cameras base speed used for off-speed calculation to 24.000 instead of 30. This 
allows the ratio calculations to take into account the 3/2 pull-down that happens when 24 frame 
film is converted to 29.97 Video in Telecine.  A good rule of thumb is that if the camera is 
rolling at 24fps and your TC frame-rate is not at the same rate, then double click this label to 
make the camera normal speed be 24.  Then enter the new off-speed frame rate and click on the 
Set Speed button.   Always Reset the speed to normal before choosing another frame-rate. 
Or before moving to another file 
 
 The Sample Rate, Time Code Stamps and Playback ratio are written to the files Format and 
Bext Chunk.  Then when the file is played on the set its, speed and Timecode will be offset by 
the ratio so you can use the TC display in BWF-Widget as a TC slate to sync up the off-speed 
track. Remember to Reset the speed to normal before leaving the file or it will remain 
permanently off speed. You should NOT use this tool if the camera is rolling off speed and will 
be transferred in Telecine at the same Off Speed. In other words if the film is shot at 6 frames 
per second and will be played out in Telecine at 6 Frames per second you should not change 
the speed of the playback when shooting. 
 
The other information in the Debug and Tweak Window shows things like byte offset and 
length of each chunk in the file, the rows and columns selected in the Data Grid, the duration 
of the file in seconds, the position of the cursor in the Chunk Viewer relative to the start of the 
file and the start of the chunk. It also shows the Filename for the saved Data Files and the Path 
to the current directory. 



 
Batch Processing Files 
You can use the batch processing feature to select a large group of files from the Data Grid to 
have their Sample Rate Pulled up or down .1% or to Rename a batch of files using the Scene 
and Take information from the Metadata. To access the batch processing window, either select 
a range of files or use the "T" key to Red-Tag files that will be sent for batch processing and 
Right-Click the mouse in the grid and choose "Batch Process Selected Files" or "Batch Process 
Red-Tagged Files" 
 

 
 
This will bring up the batch processing window that will have the selected files ready for 
processing. Use the radio buttons to choose Pull-up .1%  or Pull Down .1% And remember to 

select whether or not to compensate the Time 
Stamp for the sample rate change.  You can also 
choose to Rename Files using Scene and Take 
information. If you do choose to rename files 
make sure they have information in the Scene and 
Take fields of the metadata or the filenames will 
be unchanged for all files that lack any data in 
those fields.  The Batch rename function will 
formulate a new filename with an "S" followed by 
the Scene number then a "T" followed by a 3 digit 
Take number.  If the files are Broadcast wave 
Mono files a channel suffix  like "_3.wav" will be 
retained from the original filename.  When you 
click on the "Process Files" button new filenames 
will be generated and be displayed in the New 

Filenames List..  Remember if you are using the rename function you cannot have illegal 
characters as part of your Scene number in the Metadata.  No '\" backslash or"/" forward slash 
or other symbols that would not be allowed as part of a filename. 
 
When you are through running the batch processing click on the "Done"' Key to close the 
Batch Process Window. The status windows at the bottom of the window will show will show 
that the correct number of files were treated and what the new filenames are. Files that have no 
Scene and Take info in the bext chunk will NOT be renamed. 
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Fixing Odd Length files using Batch Processing 
Some recorders can mistakenly record files that end up to be an odd number of bytes. This can 
happen when recording 24 bit files with odd track counts. Some software and hardware may 
have difficulty loading or playing files that do not conform strictly with the BWF format 
specifications which mandates even or "word aligned" data chunks. When BWF-Widget Pro 
detects a file with an odd byte count in its data chunk, it marks it in the Mode field by adding 
an asterisk (*) to the Mode data. (For example "*Poly 24 Bit 3 track".)  You can sort the grid 
on the Mode column and any files with Odd byte counts will be brought to the top of the grid 
list.  You can then select all the files with an asterisk in the Mode column, then right click on 
the grid and choose Batch Process Selected files. In the Batch process window check the 
checkbox labeled "Fix Odd Length Files"  When you click the Process  Files Button, all the 
odd length files you have selected will be adjusted by adding an additional sample to make the 
byte count even, then the data chunk and file sizes in the file header will be corrected for the 
new (now even) file length.  This process is quite quick and hundreds of odd-length files can 
be processed in just a few seconds. 
 
Batch Conversion to Broadcast Wave Files 
You can use the Batch Process Window to convert a group of standard PCM Wav files to 
Broadcast wave files, adding the Time Stamp and Metadata to the regular wav file. To batch 

convert, check the box at the bottom of the 
Batch Process window labeled “Convert To 
BWF File.”  Once checked, two other choices 
appear: “Use File’s Time/Date” and “Use This 
Time Code”.  If you want all the files to be 
stamped with the same start time, enter that 
start time in the box in the form: 
HH:MM:SS:FF 
(Hours:Minuets:Seconds:Frames) 
And select the “Use This Time Code” radio 
button. If you Choose “Use File’s Time/Date”, 
the file’s creation Time (to the second) will be 
used as the start TC Time Stamp and the File’s 
creation Date will be entered in the User Bits. 
This will allow the files to be placed in the 
sequence that they were originally recorded 

based on their time and date stamps. 
 
Of course, once the files have been converted to Broadcast Wav, you can use this program to 
go in and Edit or add to any of that Metadata or change the TC Time Stamp. The Default TC 
Frame Rate found in the Options Menu will be used as the TC frame Rate for all batch 
converted files. Make sure it is set to the Frame Rate you want the file to be before making the 
conversion by clicking on the “Process Files” button. 
 

Note: during conversion, a new bext chunk is added to the end of the file. Some 
recorders (notably the SD744t) currently require the bext chunk to be first in 
order to recognize and playback the tile with TC. The batch conversions happen 
very quickly because the chunk is added at the end of the files.  If you need 
compatibility with the SD744t you may have to use a feature in BWF-O-Matic 
which will move the bext chunk to the first position in the file. However to do 
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so, the entire file must be copied to a new one, lengthy recordings can take a 
while for this conversion to complete. (20-30% of the file’s play time).  We are 
hoping to get Sound Devices to improve their parsing routines to recognize the 
bext chunk wherever it may be, but for now there is a solution in BWF-O-Matic 

 
Batch Conversion to MP3 Files 
BWF-Widget Pro can use the open-source LAME MP3 Encoder to batch convert your stereo 
or mono broadcast wave files to MP3 files and can put some of the Metadata like Time Code, 
User Bits, Scene and Take Numbers and Notes into the ID3 Tag on each respective MP3 file. 
Note: MP3 is only a Stereo or Mono format. Multi track files with more than 2 tracks can not 
be converted to MP3 directly. You must split off 1or 2 tracks using BWF-O-Matic or some 
other poly to Mono file conversion utility prior to running the batch conversion program. 
 
If the file "Lame.exe" is included in same folder as your BWF-Widget Pro Program you will 
see the menu choices "Batch Convert Selected to MP3" and "Batch Convert Red Tagged to 
MP3" choices in the Right Click Context menu for the Data Grid.  Start by selecting the files 
you want to encode to MP3 files. When you click on the "Batch Convert Selected to MP3" the 
batch process window will appear showing the list of files to process, a MP3 Settings pane, and 
a place to choose the destination folder for the converted files. 
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 After you have selected the Destination 
Folder by using the "Browse" button, and 
selected the encoding options in the 
Settings box, Click on the Process Files 
button to start the encoding process. The 
High-Quality Setting takes longer to 
process but produces a little higher q
output file.  The "Faster Mode" setting 
speeds up encoding but the quality may 
suffer some. These two choices are 
mutually exclusive. You should normally 
have the "Add Metadata" box checked if 
you have Time code and Scene and take 
info in the original wav file. This data w
be placed in the ID3 Tag of the MP3 File 
and can be used by BWF-Widget Pro to 

playback the MP3 file with Time code. If you want a bit-rate other than the Default 128Kb 
choose it from the drop-down bit rate box.  128Kb is FM broadcast quality. Lower bitrates 
(down to 32kb) can be chosen for smaller file size and higher bit rates can be chosen for higher 
quality sound but larger file size. You can also reduce file size if you have stereo files by 
clicking on "Mono Mix" checkbox which will mix the stereo Wav file down to a mono MP3. 
 
Once you click on the" Process Files" button, A black command window will open and show 
you the progress of the encoding of each file as it is encoded. New MP3 Files are created and 
the original WAV files are not changed or removed.  When all files have been encoded the 
command window will close and you can then click on the "Done" Button to close the Batch 
Process window.  
 



Bwf-Widget Pro can be used to playback these Compressed MP3 files with running Time Code 
that is representative of the actual time code in the original BWF or WAV file. Also, if the 
Metadata from the original was included in the ID3 Tag of the MP3 file, that metadata can be 
gathered in the grid and printed or saved, just like that from the original broadcast wave files. 
 
The LAME MP3 Encoder engine used to create the MP3 files is an open -source program 
available at www.MP3Dev.org. It has been included for your convenience but can be 
downloaded and updated separately from BWF-Widget Pro. In order for the Batch Conversion 
process to work properly with BWF-Widget pro you must keep the lame.exe file in the same 
folder as the BWF-Widget Pro Application. (Usually C:\Program Files\Bwf Widget Pro.) 
 
Foot Pedal Settings 
When using BWF-Widget Pro for Logging or Transcription, a Foot -Pedal control can be 

connected to any RS232 Serial port on the computer. This 
allows you to remain in your Word Processing program and 
continue typing, while controlling the Playback of your 
audio file by depressing the appropriate Play/Pause, Rewind 
or Fast Forward pedals on any standard Transcription Foot 
pedal control compatible with Sony WavPedal™   like the 
one pictured here. (You don't need the Sony WavPedal 
software or any other proprietary software to use the 
WavPedal™ with BWF-Widget Pro) To turn on the foot-
pedal controls, go to the Foot pedal Settings under the View 

menu. This will reveal the Foot Pedal Control settings panel on the right side of the Options 
screen.  

 
 
Before you enable the Pedal you need to select the proper COM port where your RS232 Foot 
Pedal is attached. Click on the COM port drop-down box to select the proper port. The 
available COM ports on your computer are shown in the Dropdown.  If  a COM port has an 

"NA" or "Modem" designation it will Not be Available for use with the 
foot pedal. If using a standard 9 Pin Serial connector you will probably be 
in COM 1. If using an RS232 to USB adaptor, the foot pedal may show 
up on COM  4 or 5. Once you have selected the COM port click in the 
Enable Pedal Checkbox, and test the pedal by tapping the Play pedal. The 
Status Box should show the pedal state if you have all the settings c
Once you confirm the proper operation of the foot pedal, there are other
settings in the Foot-Pedal Settings box to allow you to swap the function 
of the Fast Forward and Rewind pedals. You can also set the speed for 
Fast Forward and Rewind, as well a  choose what format the Time Code
will be in when using the automatic copy to Clipboard function when y
play or pause the track. 

orrect. 
 

the 
 

ou 
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AutoBackup 
This feature controls whether the playback will automatically backup or 
go back a prescribed amount whenever the foot pedal is released (audio 
paused). Clicking the mouse on the word "AutoBackup" in the Foot 
Pedal control panel will increase the amount of backup applied by 1/2 
second for each click.   (up to a maximum of 5 sec.) Double-Click  to 
reset the control to OFF. 
 
AutoPlay Next 
Also in the Foot Pedal control panel is a checkbox labeled “AutoPlay 
Next”. 
When playing files from either the File List box or the Data Grid, if the 
box is checked, and you double click on a file in the Grid or the List 
box, the selected file will play  and when it ends  will automatically load 
and play the next file in the list until you stop or all the files in the 
DataGrid or File List box have been played. This feature is useful for 
transcription since it can play out all the files in the Grid in Time Code 
Order.  
 
Always On Top 
Select the checkbox labeled "Always On Top" at the bottom of the Foot 
Pedal Controls Section of the Options Menu.  This will keep BWF-
Widget Pro window always on top when doing playback for transcription. You can then re-size 
the BWF-Widget Pro window down to a small portion of the screen showing only the Time 
Code Windows and File Window. This window will then always sit on top of your word 
processing program or other program used for logging or transcription. 
 
Exiting the program: 
When you exit the program by either using "File - Exit" from the drop down menu. Or press 
the Ctrl-X hot-key, your current settings and the path to the current directory are saved so you 
can return to the same folder next time you start the program. 
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